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I. Giíi thiÖu chung 

I.1. §Æt vÊn ®Ò 

Trong thêi gian võa qua, viÖc kh«ng thèng nhÊt sö dông mét bé m· trong c¶ n−íc 
(miÒn B¾c dïng Font ABC, miÒn Nam Font VNI) ®· g©y khã kh¨n kh«ng nhá 
trong viÖc trao ®æi th«ng tin d÷ liÖu gi÷a c¸c ®¬n vÞ víi nhau, ®ång thêi còng g©y 
nhiÒu trë ng¹i cho viÖc triÓn khai øng dông trªn m¹ng Internet vµ m¹ng diÖn 
réng. 

Ngµy 24/9/2001, Bé Khoa häc C«ng nghÖ vµ M«i tr−êng ®· ban hµnh tiªu chuÈn 
ViÖt Nam: TCVN 6909:2001 dùa trªn b¶ng m· Unicode vµ ISO 10646 vµ QuyÕt 
®Þnh sè 72 cña Thñ t−íng ChÝnh phñ vÒ viÖc thèng nhÊt sö dông b¶ng m· tiÕng 
ViÖt trong khèi c¬ quan Nhµ n−íc lµ nh÷ng c¬ së ph¸p lý vµ ®iÒu kiÖn thuËn lîi 
cho viÖc thèng nhÊt mét b¶ng m· tiÕng ViÖt duy nhÊt trong c¶ n−íc. 

¦u ®iÓm chÝnh cña bé m· tiÕng ViÖt Unicode/TCVN 6909:2001: 

- Cã ®Çy ®ñ ch÷ hoa vµ ch÷ th−êng tiÕng ViÖt. 

- Cho phÐp tiÕng ViÖt héi nhËp víi tÊt c¶ c¸c ng«n ng÷ chÝnh kh¸c trªn thÕ 
giíi. 

- Kh«ng bÞ c¸c lçi mÊt ch÷ hoÆc tranh chÊp víi c¸c ký tù ®iÒu khiÓn. 

- §¶m b¶o tÝnh tu©n thñ c¸c tiªu chuÈn ISO 10646 vµ UNICODE, lµ nh÷ng 
chuÈn ®−îc ¸p dông trong c¸c c«ng nghÖ tiªn tiÕn. §−îc c¸c h·ng cam kÕt 
hç trî trong c¸c s¶n phÈm míi. 
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I.2. PhÇn mÒm hç trî xö lý tiÕng ViÖt Unicode 

Vietkey Group /Vietkhang JSC lµ ®¬n vÞ cã h¬n 10 n¨m kinh nghiÖm x©y dùng 
c¸c c«ng cô xö lý tiÕng ViÖt cho c¸c m¸y tÝnh PC. Ngµy nay Vietkey Group cã 
phÇn mÒm xö lý tiÕng ViÖt cho rÊt nhiÒu m«i tr−êng kh¸c nhau: MS Windows, 
Unix/Linux, Pocket PC, Palm...C¸c c«ng cô xö lý tiÕng ViÖt cña Vietkey Group 
rÊt ®a d¹ng, phong phó vµ hoµn chØnh, tõ bé gâ tiÕng ViÖt cho m¸y Palm cho ®Õn 
hÖ ®iÒu hµnh th−¬ng hiÖu ViÖt Nam hoµn chØnh Vietkey Linux. Trong tµi liÖu nµy 
chóng t«i chñ yÕu ®Ò cËp ®Õn c¸c c«ng cô xö lý tiÕng ViÖt trong m«i tr−êng 
Windows: 

- C«ng cô nhËp th«ng tin tõ bµn phÝm (bé gâ tiÕng ViÖt Vietkey) 

- C«ng cô chuyÓn ®æi ch÷ hoa/ch÷ th−êng. 

- C«ng cô kiÓm tra chÝnh t¶ tiÕng ViÖt. 

- C«ng cô s¾p xÕp tiÕng ViÖt. 

- C¸c c«ng cô chuyÓn m· v¨n b¶n, d÷ liÖu tõ c¸c bé m·/bé Font cò sang tiªu 
chuÈn míi, chuyÓn m· c¸c tÖp v¨n b¶n (Word, Excel), c¸c trang Web vµ 
c¬ së d÷ liÖu. 

- Bé th− viÖn lËp tr×nh xö lý tiÕng ViÖt cho c¸c m«i tr−êng lËp tr×nh. 

VietKey ®· ®−îc ®¨ng ký b¶n quyÒn theo sè 1671 VH/BQ ngµy 22 th¸ng 12 n¨m 
1997 t¹i Côc B¶n QuyÒn T¸c Gi¶ - Bé V¨n Hãa. B¶n quyÒn thuéc vÒ t¸c gi¶ §Æng 
Minh TuÊn, tr−ëng nhãm Vietkey Group. Vietkhang JSC lµ c«ng ty ®−îc uû 
quyÒn kinh doanh vµ ph©n phèi c¸c s¶n phÈm hä Vietkey. Mäi söa ®æi kh«ng 
®−îc phÐp ®èi víi víi c¸c file ch−¬ng tr×nh, logo, h−íng dÉn (Help) cña VietKey 
®Òu vi ph¹m luËt b¶n quyÒn. 
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Khi bé s¶n phÈm Vietkey ®−îc b¸n ra, theo quy ®Þnh, ng−êi sö dông chØ ®−îc 
phÐp cµi ®Æt trªn tõng m¸y ®¬n lÎ. Cµi ®Æt trªn m¹ng côc bé hoÆc cho sè l−îng 
lín trong mét c«ng ty  cÇn ph¶i cã giÊy b¶n quyÒn sö dông tõ phÝa nhµ ph©n 
phèi. 

I.3. Yªu cÇu cho viÖc triÓn khai TCVN 6909  

I.3.1 Yªu cÇu vÒ thiÕt bÞ phÇn cøng 

o M¸y tÝnh tõ 386 trë lªn. 

o Bé nhí RAM: 16 MB trë lªn. 

o æ cøng HDD: 300 MB (®Ó cã thÓ cµi tèi thiÓu ®−îc Win95 vµ 
Office 97). 

o Kh«ng gian ®Üa cho bé gâ Vietkey: 150KB, Font Unicode vµ bé 
Font ABC, VNI: 10MB, bé Vietkey Office: 1MB. 

I.3.2 Yªu cÇu vÒ phÇn mÒm 

o HÖ ®iÒu hµnh: Windows 95/98, Windows NT, Windows 2000, 
Windows XP, Pocket PC 2002 hoÆc Linux cã kernel 2.0 trë lªn. 

o So¹n th¶o v¨n b¶n: Microsoft Office 97/2000/XP, Open Office. 

o Tr×nh duyÖt Web: Internet Explore 4.0 trë lªn, Netscape 4.7 trë 
lªn. 
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o Th− tÝn ®iÖn tö: Outlook Express 5 trë lªn, Netscape Mail 4.7 trë 
lªn. 

o C¬ së d÷ liÖu: MS Access 2000, SQL Server 6.5 trë lªn, 
ORACLE... 
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II. Bé gâ tiÕng viÖt ®a n¨ng vietkey 

II.1. Giíi thiÖu chung vÒ bé gâ 

Bé gâ Vietkey lµ bé gâ ®−îc ra ®êi tõ rÊt sím, phiªn b¶n 1.0 ph¸t hµnh n¨m 
1993. Vietkey lµ mét trong nh÷ng bé gâ tiÕng ViÖt 32-Bit ®Çu tiªn vµ còng lµ mét 
trong nh÷ng bé gâ ®Çu tiªn hç trî Unicode. Bé gâ Vietkey cã nhiÒu tÝnh n¨ng −u 
ViÖt: 

- Nhá gän, chØ cÇn File duy nhÊt. 

- Ch¹y trªn tÊt c¶ c¸c m«i tr−êng Windows 32-Bit, bao gåm: Windows 
95/98, Windows NT, Windows 2000, Windows XP. §èi víi MS Pocket 
PC cÇn ph¶i cã phiªn b¶n kh¸c lµ Vietkey CE. 

- Hç trî gâ nhiÒu ng«n ng÷ phæ th«ng: ViÖt, Nga, Anh, Ph¸p, §øc... 

- Hç trî c¸c b¶ng m· tiÕng ViÖt phæ th«ng: ABC, VNI...Unicode/ TCVN 
6909:2001. Riªng víi Unicode, hç trî c¸c biÓu diÔn UTF-8, UCS2 (cho 
c¸c m«i tr−êng Web), C-Style: Unicode cho m«i tr−êng lËp tr×nh C, C++. 

- Hç trî nhiÒu kiÓu gâ th«ng dông ë ViÖt Nam còng nh− ë n−íc ngoµi: 
TELEX, VNI, VIQR. 

- Cã nhiÒu tÝnh n¨ng n©ng cao: gâ t¾t c¸c tõ môc kh«ng h¹n chÕ, tù ®éng 
chuyÓn chÕ ®é Anh-ViÖt víi kiÓu gâ Telex, cho phÐp gâ lÆp dÊu-khö dÊu 
lµ tÝnh n¨ng còng do Vietkey Group c¶i tiÕn vµ ®−a ra ®Çu tiªn ë ViÖt Nam 
(1991). 
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II.2. Cµi ®Æt Bé gâ tiÕng ViÖt VIETKEY 

II.2.1 Cµi ®Æt bé gâ tiÕng ViÖt tèi thiÓu 

Bé gâ tiÕng ViÖt Vietkey cã kÝch th−íc 150K, kh«ng cÇn cµi ®Æt, chØ cÇn copy 
tÖp VKNT.EXE vµo mét th− môc bÊt kú trªn æ cøng (vÝ dô th− môc C:\vietkey) 
vµ nh¾p chuét vµo biÓu t−îng cña Vietkey, bé gâ tiÕng ViÖt sÏ ®−îc kÝch ho¹t. 
Víi kÝch th−íc 150 KB, Vietkey dÔ dµng chuyÓn mang trªn m¹ng hoÆc copy trªn 
®Üa mÒm ®Ó cµi ®Æt vµo c¸c m¸y míi.  

II.2.2 Cµi ®Æt bé gâ ®Çy ®ñ bao gåm c¶ c¸c font ch÷ 

Bé Vietkey ®Çy ®ñ (Full Version) cã h¬n 7 ®Üa mÒm hoÆc ®−îc l−u trªn ®Üa CD 
cã c¸c th− môc con lµ disk1, disk2, disk3, disk4, disk5, disk6, disk7. Bé ®Çu ®ñ 
bao gåm c¸c font ch÷ Unicode /TCVN 6909 vµ c¸c bé font cò (®−îc dïng trong 
thêi gian qu¸ ®é) : ABC vµ VNI. 

C¸c b−íc cµi ®Æt: 

1. Cho ®Üa Vietkey vµo æ CD, hoÆc cho ®Üa Vietkey 1 (nÕu dïng ®Üa mÒm), 
hoÆc chän vµo th− môc Disk1 nÕu ®· copy trªn ®Üa cøng. 
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2. Nh¾p chuét (Mouse) vµo nót start, mét cöa sæ xuÊt hiÖn, chän vµo môc 
Run nh− h×nh vÏ sau: 

 

 

 

 

 

 

3. Sau khi cöa sæ Run xuÊt hiÖn, gâ trong « text d:\disk1\setup nÕu æ CD 
®−îc ®Þnh nghÜa lµ æ D, hoÆc cã thÓ nh¾p chuét vµo nót Browse ®Ó chän 
®óng tÖp setup.exe trong ®Üa 1 cña bé cµi ®Æt Vietkey n»m trªn ®Üa cøng 
hoÆc trªn ®Üa mÒm A nh− h×nh d−íi ®©y: 
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4. Sau khi ch−¬ng tr×nh cµi ®Æt Setup.exe ch¹y, nh¾p chuét vµo nót Next 2 
lÇn cho ®Õn khi hiÖn ra cöa sæ Select Setup Type, b×nh th−êng ch−¬ng 
tr×nh vµ c¸c font ch÷ sÏ ®−îc cµi ®Æt vµo th− môc c:\program 
files\vietkey2000, ®Ó thay ®æi th− môc kh¸c cã thÓ nh¾p chuét vµo nót 
Browse. Sau ®ã nh¾p chuét vµo môc Custom trong cöa sæ nh− h×nh sau: 
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5. Sau khi chän nót Custom, cöa sæ Select Component sÏ xuÊt hiÖn nh− 
h×nh  sau: 

 

 

 

 

 

 

 

 

 

 

 

 

- Trong môc Component, nh¾p chuét vµo c¸c môc font cÇn cµi ®Æt, chó ý 
cÇn nh¾p chuét ®Ó cã dÊu tick (dÊu hÊt h×nh ch÷ V) vµo môc VN Unicode 
Fonts ®Ó cã ®−îc font ch÷ Unicode trªn c¸c m¸y Windows 95, Windows 
98, Windows NT. Víi c¸c hÖ ®iÒu hµnh Windows 2000, Windows ME 
hoÆc Windows XP, kh«ng cÇn chän vµo môc VN Unicode Fonts v× c¸c 
Font nµy ®· cã s½n trªn hÖ ®iÒu hµnh. 
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- Chó ý: ch−¬ng tr×nh cµi ®Æt nµy còng cã thÓ cµi ®Æt font hÖ thèng tiÕng 
ViÖt cho Windows (font hÖ thèng lµ c¸c font ®−îc dïng trong Menu, c¸c 
th«ng b¸o...) tuy nhiªn Font hÖ thèng tiÕng ViÖt nµy míi chØ hç trî bé m· 
tiÕng ViÖt cò lµ TCVN 5712, vµ font hÖ thèng nµy sÏ kh«ng cã t¸c dông 
®èi víi Windows 2000 hoÆc Windows XP. Trong mét sè phiªn b¶n 
Windows b¶n ®Þa nh− Windows tiÕng Nga, Windows tiÕng Hoa, tiÕng 
Ph¸p... sau khi cµi ®Æt font hÖ thèng tiÕng ViÖt (TCVN System Fonts) sÏ 
lµm háng hÕt c¸c th«ng b¸o b»ng tiÕng b¶n ®Þa, v× vËy chØ chän môc nµy 
khi thùc sù cÇn thiÕt. 

6. Nh¾p chuét vµo c¸c nót Next sau ®ã vµ cuèi cïng lµ nót Finish. 

7. Khëi ®éng l¹i m¸y vµ qu¸ tr×nh cµi ®Æt font ch÷ vµ bé gâ tiÕng ViÖt sÏ 
®−îc kÕt thóc. 

II.3. NhËp th«ng tin (gâ) tiÕng ViÖt b»ng vietkey 

§Ó nhËp ®−îc tiÕng ViÖt vµ hiÓn thÞ ®óng trong c¸c øng dông cÇn ph¶i: 

- Chän ®óng Font ch÷ tiÕng ViÖt trong c¸c øng dông, 

- Chän ®óng b¶ng m· (Character Set) trong Vietkey, 

- Chän ®óng kiÓu gâ trong Vietkey. 

II.3.1 Chän font ch÷  tiÕng ViÖt trong c¸c øng dông 

Trong c¸c øng dông MS Word, MS Excel, MS PowerPoint, OutLook, FrontPage, 
Access 2000... víi bé m· UNICODE /TCVN 6909 cÇn ph¶i chän tªn Font trong 
c¸c hép font ch÷ lµ mét trong c¸c font sau ®©y: 

Arial, Times New Roman, Tahoma, Courier, Platino Linotype, Verdana... 
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Chó ý: víi c¸c hÖ ®iÒu hµnh Windows 2000, Windows ME, Windows XP th× c¸c 
font nãi trªn mÆc nhiªn lµ Unicode, ®èi víi c¸c hÖ ®iÒu hµnh cò h¬n nh− 
Windows 95/98 th× cÇn ph¶i cµi l¹i font ch÷ nh− môc II.1. 

II.3.2 Chän b¶ng m· tiÕng ViÖt trong Vietkey 2000 

- Khëi ®éng Vietkey, b»ng c¸ch nh¾p chuét vµo biÓu t−îng Vietkey, cöa sæ 
®iÒu khiÓn cña Vietkey sÏ xuÊt hiÖn. 

- Nh¾p chuét vµo nót Char Sets (B¶ng m·). 

- Sau ®ã chän vµo môc Unicode Pre-Compound, TCVN 6909:2001 
(Unicode dùng s½n). 
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- Cã thÓ chän nhanh b¶ng m· tiÕng ViÖt khi Vietkey ®ang n»m ë thanh 
Taskbar b»ng c¸ch nh¾p chuét ph¶i vµo biÓu t−îng Vietkey trªn thanh 
Taskbar, khi Êy mét cöa sæ thùc ®¬n xuÊt hiÖn vµ nh¾p chuét vµo dßng 
ch÷ Unicode. 

 

 

 

 

 

 

 

 

 

 

 

- Vietkey cho phÐp chuyÓn nhanh c¸c b¶ng m· b»ng tæ hîp phÝm nãng. 
Control+Shift+F1, Control+Shift+F2,Control+Shift+F3 Vietkey sÏ 
chuyÓn sang 3 b¶ng m· lÇn cuèi cïng ®−îc chän. 
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II.3.3 Chän kiÓu gâ tiÕng ViÖt 

Trong cöa sæ cña Vietkey, nh¾p chuét vµo môc KiÓu gâ/Input Methods, chän 
kiÓu gâ t−¬ng øng lµ TELEX hay VNI tuú theo thãi quen ng−êi dïng, ngoµi 2 
kiÓu gâ chÝnh phæ biÕn ë ViÖt Nam hiÖn nay, Vietkey cßn cung cÊp cho ng−êi 
dïng 9 kiÓu gâ kh¸c nhau lµ VIQR, Vietware, TCVN, BKtpHCM, VNU, VNSea, 
VNA. 
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II.3.4 Quy t¾c gâ tiÕng ViÖt 

II.3.4.1. Quy t¾c chung 

1. C¸c dÊu mò vµ dÊu tr¨ng, dÊu r©u ph¶i gâ trùc tiÕp vµo nguyªn ©m, dÊu 
(huyÒn, s¾c, hái, ng·, nÆng) cã thÓ gâ trùc tiÕp hoÆc sau nguyªn ©m cÇn bá 
dÊu tõ 1 ®Õn 3 ký tù tøc lµ cã thÓ bá dÊu ViÖt ngay t¹i nguyªn ©m hoÆc ë 
cuèi tõ (bá dÊu tù ®éng).  Nªn bá dÊu tù ®éng ®Ó tr¸nh bá sai dÊu hoÆc 
tr¸nh lçi 1 tõ cã nhiÒu dÊu vµ víi c¸ch bá dÊu tù ®éng, dÊu bao giê còng 
thèng nhÊt do ®ã viÖc t×m kiÕm, s¾p xÕp tiÕng ViÖt míi cã thÓ thùc hiÖn 
®−îc. 

2. Trong tr−êng hîp gâ sai dÊu cã thÓ gâ ngay dÊu kh¸c kh«ng cÇn ph¶i xo¸ 
ch÷ ®Ó gâ l¹i. 

3. C¸c phÝm dÊu chØ cã t¸c dông theo ng÷ c¶nh tøc lµ nÕu kh«ng cã nguyªn 
©m nµo trong vïng t¸c dông th× nã vÉn hiÓn thÞ nh− trong chÕ ®é tiÕng 
Anh, vÝ dô phÝm ‘f’ nÕu ®i sau ch÷ ‘a’ th× sÏ thµnh ch÷ ‘µ’, cßn nÕu gâ 
riªng nã vÉn hiÖn ch÷ f, t−¬ng tù nh− vËy trong kiÓu gâ VNI, c¸c phÝm sè 
vÉn hiÖn lµ sè nÕu nã kh«ng ®i sau nguyªn ©m cã kh¶ n¨ng cã dÊu. 

4. Víi kiÓu bá dÊu tù ®éng c¸c phÝm dÊu chØ cã t¸c dông khi ®»ng sau 
nguyªn ©m cã dÊu chØ cã nh÷ng phô ©m hîp lÖ: <c,g,h,m,n,p,t>. 
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II.3.4.2. Quy t¾c gâ tiÕng ViÖt kiÓu Telex 

Qui −íc, ý nghÜa cña c¸c phÝm: 

PhÝm T¸c ®éng dÊu 

f HuyÒn 

s S¾c 

r Hái 

x Ng· 

J NÆng 

w DÊu tr¨ng trong ch÷ ‘¨’, dÊu mãc trong c¸c ch÷ 
‘¬’,'−’. Go phÝm ‘w’ ®¬n lÎ sÏ ra ch÷ ‘−’ 

z Khö dÊu (xo¸ dÊu) ®· ®Æt 

aa © 

aw ¨ 

ee ª 

oo « 

dd ® 

ow, ] ¬ 

w, uw, [ − 
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LÆp dÊu: 
 

PhÝm KÕt qu¶ 

ddd dd 

ooo oo 

eee ee 

[[ [ 

]] ] 
 
CÆp ch÷ −¬ rÊt hay gÆp trong tiÕng ViÖt, ®Ó gâ nhanh cã thÓ gâ 2 phÝm ][ gÇn 
nhau vµ theo chiÒu h−íng vµo t©m bµn phÝm nªn ®¹t ®−îc tèc ®é cao do gi¶m 
®−îc mét nöa sè thao t¸c cña c¸c phÝm c¸ch xa nhau uwow. 

VÝ dô: 

Gâ dßng ch÷ B»ng d·y c¸c phÝm  

N−íc ch¶y ®¸ mßn - Nwowcs chayr ddas monf  

- N][cs chary ddas mofn 

Thoßng - Thooongf 

- Tho<control>ongf 

§−êng - DDuwowngf 

- DDwowngf 

- dD][ngf 
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II.3.4.3. Quy t¾c gâ tiÕng ViÖt kiÓu VNI 

Qui −íc, ý nghÜa cña c¸c phÝm: 

 

 

 

PhÝm T¸c ®éng dÊu 

1 S¾c 

2 HuyÒn 

3 Hái 

4 Ng· 

5 NÆng 

6 DÊu mò cña c¸c ch÷ ‘©’, ‘ª’ vµ ‘«’ 

7 DÊu r©u cña ch÷ ‘¬ ‘vµ ‘−’ 

8 DÊu tr¨ng cña ch÷ ‘¨’ 

d9 ® 

0 Khö dÊu (xo¸ dÊu)                    
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VÝ dô: 

Gâ dßng ch÷ B»ng d·y c¸c phÝm  

N−íc ch¶y ®¸ mßn - Nu7o71c  cha3y d9a1 mo2n 

- Nu7o7c1  chay3 d9a1 mon2 

Thoßng - Thoong2 

§−êng - D9u7o7ng2 

®· - d9a4 

 
  
Dïng phÝm <control> ®Ó gâ c¸c ch÷ sè vµ c¸c ký tù <!,@.#,(,)..> sau c¸c nguyªn 
©m. 

VÝ dô: 

 A! = A<control>! 

II.4. ChuyÓn chÕ ®é gâ tiÕng ViÖt, tiÕng Anh: 

1. Cã thÓ chuyÓn chÕ ®é gâ tiÕng ViÖt sang chÕ ®é gâ tiÕng Anh (hay Nga, 
Ph¸p, §øc) b»ng tæ hîp phÝm ALT-Z. Tæ hîp phÝm chuyÓn nµy cã thÓ 
thay b»ng tæ hîp phÝm kh¸c <Control-Control> hoÆc <Control-Shift>  
trong môc Tuú chän(Option). Thay ®æi tæ hîp phÝm chuyÓn chÕ ®é nh»m 
tr¸nh c¸c phÝm tranh chÊp trong mét sè phÇn mÒm chuyªn dông nh− 
Photoshop... 

2. Nh¾p nót ph¶i chuét vµo biÓu t−ëng cña Vietkey trªn thanh Taskbar,  
chän chÕ ®é gâ ViÖt-Anh. 
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II.5. ThiÕt lËp gâ t¾t – AutoText 

- Trong môc Tuú chän (Option) nh¾p chuét ®Ó bËt chÕ ®é Cho phÐp gâ t¾t 
(Enable AutoText). 
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- Nh¾p chuét vµo nót §Þnh nghÜa gâ t¾t (AutoText Items) ®Ó thiÕt lËp c¸c 
môc tõ gâ t¾t. 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Gâ t¾t lµ chÕ ®é cho phÐp thay mét chuçi ký tù dµi b»ng mét chuçi ký tù 
ng¾n h¬n. Gâ t¾t cho phÐp t¨ng tèc ®é gâ, nhËp v¨n b¶n, ®ång thêi cã thÓ 
chuÈn ho¸ ®−îc d÷ liÖu, thèng nhÊt cho mét c¬ quan. VÝ dô chuçi “hn’ cã 
thÓ thay b»ng chuçi “Hµ Néi”, nhê viÖc gâ t¾t cã thÓ chuÈn ho¸ ®−îc kh©u 
nhËp d÷ liÖu, tr¸nh c¸c tæ hîp kh¸c nhau nh− “hµ néi”, “Hµ néi”. ViÖc 
kh«ng chuÈn ho¸, kh«ng thèng nhÊt sÏ g©y nhiÒu khã kh¨n trong viÖc t×m 
kiÕm, thèng kª... 
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- Vietkey cho phÐp ®Þnh nghÜa kh«ng h¹n chÕ c¸c môc gâ t¾t thªm, söa, 
xo¸ (Add, Modify, Delete), ®ång thêi còng cho phÐp l−u c¸c môc gâ t¾t 
ra c¸c File kh¸c nhau Tªn míi (Save as).  

- Nhê viÖc §æi File(Change File) Vietkey cho phÐp cã thÓ thay ®æi c¸c bé 
gâ t¾t mét c¸ch nhanh chãng vµ tiÖn lîi, tuú theo lÜnh vùc ®ang xö lý v¨n 
b¶n. C¸c File gâ t¾t nµy cã thÓ ®−îc l−u tr÷, trao ®æi cho nhiÒu ng−êi dïng 
chung mét quy −íc gâ t¾t nhê vËy cã thÓ gãp phÇn thèng nhÊt kh©u nhËp 
d÷ liÖu trong ph¹m vi c¬ quan tæ chøc.. VÝ dô “tp” trong mét sè tr−êng hîp 
cã thÓ lµ gâ t¾t cña “Thµnh phè”, nh−ng trong File gâ t¾t kh¸c cã thÓ lµ 
“thÞ phÇn”. 

II.6. Tù t¹o biÓu t−îng cho Vietkey. 

- Vµo môc Utilities (C«ng cô)  chän Create Vietkey Icon on Desktop 
(T¹o biÓu t−îng Vietkey trªn Desktop). 

II.7. §Æt chÕ ®é tù khëi ®éng Vietkey 

- Vµo môc Utilities (C«ng cô)  chän Run Vietkey at Boot Time 
(Lu«n ch¹y Vietkey khi khëi ®éng PC). 
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II.8. Thay ®æi giao diÖn hiÓn thÞ tiÕng ViÖt trong b¶ng 
®iÒu khiÓn cña Vietkey. 

- Vµo môc Tuú chän(Option) chän Vietnamese interface( HiÓn thÞ 
tiÕng ViÖt). 
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II.9. Khëi ®éng nhanh Vietkey vµo thanh Taskbar hay 
OnTop. 

1. Vµo môc Tuú chän(Option) chän Khëi ®éng nhanh(FastLoad) 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. NhÊp chuét vµo nót Taskbar hoÆc Lu«n næi (OnTop). 
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B×nh th−êng khi khëi ®éng, b¶ng ®iÒu khiÓn cña Vietkey sÏ lu«n xuÊt hiÖn trªn 
mµn h×nh, dïng tÝnh n¨ng nµy ®Ó Vietkey bá qua b−íc hiÓn thÞ b¶ng ®iÒu khiÓn, 
vµo ngay thanh Taskbar hoÆc lu«n næi biÓu t−îng trªn mµn h×nh. 

II.10. §Æt chÕ ®é cña MS Word, Excel ®Ó gâ ®−îc tiÕng 
ViÖt TCVN 6909 

Do c¸c phÇn mÒm Word, Excel, PowerPoint... ®−îc thiÕt kÕ ®Ó phï hîp víi ng«n 
ng÷ kh«ng ph¶i tiÕng ViÖt (tiÕng Anh, Nga, Ph¸p...) mét sè chøc n¨ng tù ®éng 
hiÖu chØnh, hoÆc kiÓm tra chÝnh t¶ cña c¸c ng«n ng÷ nµy sÏ kh«ng t−¬ng hîp víi 
ng«n ng÷ tiÕng ViÖt nªn cã thÓ g©y ra mét sè trôc trÆc khi nhËp d÷ liÖu tiÕng 
ViÖt. Sau ®©y lµ c¸ch ®Æt mét sè chÕ ®é ®Ó tr¸nh sù kh«ng t−¬ng thÝch nµy: 

 

 

 

 

 

 

 

Bá dÊu check
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- Trong cöa sæ cña MS Word chän Tools/Option/Edit bá chøc n¨ng Use 
smart cut and Paste.  Bá chøc n¨ng nµy ®Ó tr¸nh hiÖn t−îng c¸ch dÊu 
trèng víi c¸c ch÷ cã dÊu. 

- Trong cöa sæ cña MS Word chän Tools/AutoCorrect bá hÕt c¸c tÝnh n¨ng 
trong cöa sæ AutoCorrect.  
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- Trong cöa sæ cña MS Word chän Tools/Option/Spelling & Grammar bá 
c¸c tÝnh n¨ng: Check Spelling as You Type, Check Grammar as You 
Type, Check Grammar with Spelling.  Nh− h×nh vÏ d−íi ®©y. 
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III. Bé xö lý tiÕng ViÖt v¨n phßng Vietkey office 

III.1. Giíi thiÖu chung vÒ Vietkey Office 

 Vietkey Office lµ mé bé c«ng cô xö lý tiÕng ViÖt ®−îc tÝch hîp vµo c¸c phiªn 
b¶n MS Office 97, MS Office 2000, MS Office XP. Sau khi cµi ®Æt  Vietkey 
Office, c¸c hÖ so¹n th¶o v¨n phßng (th−êng lµ c¸c b¶n cho tiÕng Anh, Ph¸p...) sÏ 
biÕn thµnh c¸c hÖ so¹n th¶o v¨n phßng cã hç trî xö lý tiÕng ViÖt. C¸c chøc n¨ng 
c¬ b¶n cña  Vietkey Office (t−¬ng tù nh− ®· cã trong bé MS Office víi tiÕng 
Anh): 

- KiÓm tra chÝnh t¶ (spelling) tiÕng ViÖt,  

- S¾p xÕp (sorting) tiÕng ViÖt,  

- ChuyÓn ®æi ch÷ hoa/ch÷ th−êng (Change case) tiÕng ViÖt.  

- Ngoµi ra Vietkey Office cßn cã chøc n¨ng rÊt quan träng lµ chuyÓn m· c¸c 
v¨n b¶n tiÕng ViÖt.  

o Bé chuyÓn m· Vietkey Office (VKO) cho phÐp chuyÓn m· c¸c v¨n 
b¶n ®−îc so¶n th¶o trong c¸c ch−¬ng tr×nh MS Word 97/2K/XP, 
Excel, PowerPoint (trong bé MS Office) tõ 44 b¶ng m· tiÕng ViÖt 
kh¸c nhau sang Unicode vµ ng−îc l¹i. 

o So víi c¸c bé chuyÓn m· kh¸c th× VKO cho phÐp chuyÓn ®æi m· 
tiÕng ViÖt mµ vÉn gi÷ ®−îc hÇu nh− nguyªn vÑn tÊt c¶ c¸c thuéc 
tÝnh cò cña font ch÷, kÓ c¶ tªn, hä font t−¬ng øng (mÆc dï font ®Ých 
vµ font nguån cã tªn hoµn toµn kh¸c nhau). TÊt c¶ c¸c ®èi t−îng 
nh− b¶ng biÓu, ®å ho¹ vÉn ®−îc gi÷ nguyªn, ®Æc biÖt VKO cßn cho 
phÐp chuyÓn ®æi c¸c text c¶ trong c¸c Text Box, Header, Footer. 
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o VKO cßn cã chøc n¨ng tù ®éng ®o¸n m· tiÕng ViÖt ®ang dïng gióp 
cho ng−êi dïng khái lóng tóng khi chän mét trong sè h¬n 40 b¶ng 
m· kh¸c nhau. VKO cßn cho phÐp chuyÓn m· toµn bé v¨n b¶n hay 
tõng vïng côc bé ®Ó chuyÓn m· cho c¸c v¨n b¶n cã sö dông nhiÒu 
lo¹i font ch÷ kh¸c nhau.  

o C¸c v¨n b¶n Word, Excel, PowerPoint sau khi chuyÓn hÇu nh− 
kh«ng cÇn ph¶i lµm bÊt kú thao t¸c nµo ®Ó hiÖu chØnh vµ cã thÓ s½n 
sµng nhËp sè liÖu míi theo tiªu chuÈn míi (Unicode). ViÖc chuyÓn 
®æi ®· ®−îc tù ®éng ho¸ cao tr¸nh nhiÒu thao t¸c mÊt thêi gian 
(chuyÓn sang text only hoÆc chuyÓn qua RTF nh− mét sè c«ng cô 
chuyÓn m· tiÕng ViÖt kh¸c) vµ trung thµnh mét c¸ch tèi ®a v¨n b¶n 
gèc.  

III.2. Cµi ®Æt Bé xö lý tiÕng ViÖt trong MS Office 

1. Tho¸t hÕt c¸c øng dông ra khái bé nhí (kÕt thóc c¸c ch−¬ng tr×nh) ®Æc biÖt 
lµ c¸c ch−¬ng tr×nh Word, Excel, PowerPoint cÇn ph¶i kÕt thóc tr−íc khi 
cµi ®Æt c¸c c«ng cô nµy. 

2. Thùc hiÖn c¸c b−íc 1,2 gièng nh− môc II.2 tøc lµ nh¾p chuét vµo nót Start 
vµ chän môc Run vµ gâ vµo « ch÷ : d:\vkosetup.exe hoÆc nh¾p chuét vµo 
nót Browse ®Ó chän vkosetup.exe nÕu ch−¬ng tr×nh nµy n»m ë ®−êng dÉn 
hoÆc ë æ ®Üa kh¸c. 

3. Chän vµo nót §ång ý ®Ó tiÕp tôc, mét cöa sæ nh− h×nh d−íi ®©y sÏ xuÊt 
hiÖn, nh¾p chuét vµo c¸c môc MS Word, MS Excel, MS PowerPoint (®Æt 
c¸c dÊu tick vµo c¸c « vu«ng t−¬ng øng). 

4. B×nh th−êng c¸c c«ng cô nµy sÏ ®−îc cµi ®Æt vµo c¸c th− môc t−¬ng øng vµ 
th− môc c:\vietkey, nÕu muèn cµi vµo th− môc kh¸c th× cã thÓ gâ ®−êng 
dÉn kh¸c vµo « text trong cöa sæ nµy. 
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5. Nh¾p chuét vµo nót Install ®Ó cµi ®Æt. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

L−u ý: CÇn ph¶i gì bá c¸c b¶n Vietkey Office cò, ®Æc biÖt cÇn ph¶i xo¸ c¸c file: 
VKLIB.DLL, VKSPELL.DLL trong th− môc Windows (WinNT) tr−íc khi cµi 
®Æt. 
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III.3. KiÓm tra chÝnh t¶ tiÕng ViÖt 

Sau khi cµi ®Æt xong Vietkey Office, c¸c c«ng cô kiÓm tra chÝnh t¶ tiÕng ViÖt sÏ 
®−îc tÝch hîp vµ Menu VietkeyOF sÏ ®−îc nèi thªm vµo Menu cña c¸c ch−¬ng 
tr×nh MS Word, MS Excel vµ MS PowerPoint, c¸c Menu cña Vietkey Office sÏ 
thèng nhÊt xuyªn suèt c¶ 3 ch−¬ng tr×nh nµy.  

TÝnh n¨ng kiÓm tra chÝnh t¶ tiÕng ViÖt cña Vietkey Office ho¹t ®éng t−¬ng tù 
nh− tÝnh n¨ng Spelling cña MS Word. Ngoµi viÖc ph¸t hiÖn ra c¸c lçi ®¸nh m¸y, 
c¸c tõ kh«ng cã trong tiÕng ViÖt sÏ ®−îc c«ng cô kiÓm tra chÝnh t¶ tiÕng ViÖt 
ph¸t hiÖn vµ cã ®Ò nghÞ c¸c söa lçi th«ng minh. 

 

 

 

 

 

 

 

 

 

 

Chän chøc n¨ng Kiem tra chinh ta tieng Viet trong Menu VietkeyO2.1, ch−¬ng 
tr×nh hiÓn thÞ cöa sæ kiÓm tra chÝnh t¶ nh− sau:  
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Cöa sæ nµy cho phÐp chän kiÓm t¶ chÝnh t¶ tiÕng ViÖt cho toµn bé v¨n b¶n hay 
trong vïng lùa chän, hay tõ mét vÞ trÝ bÊt kú ®Õn cuèi hoÆc ®Çu v¨n b¶n. 

Khi ph¸t hiÖn ra lçi, c«ng cô kiÓm tra chÝnh t¶ tiÕng ViÖt sÏ hiÓn thÞ cöa sæ sau ®Ó 
cho phÐp söa lçi hay chän c¸c tõ ®· ®−îc ®Ò nghÞ söa lçi. C«ng cô nµy còng cho 
phÐp thªm vµo tõ ®iÓn ng−êi dïng mét sè tõ kh«ng cã trong tiÕng ViÖt nh− 1 sè 
tõ gâ t¾t. Ngoµi ra c«ng cô nµy còng cho phÐp bá qua 1 sè tõ hay thay 1 hay thay 
hÕt c¸c tõ t−¬ng øng. Xem h×nh d−íi ®©y: 
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III.4. C«ng cô S¾p xÕp tiÕng ViÖt 

Thø tù s¾p xÕp cña b¶ng ch÷ c¸i tiÕng ViÖt: 

A ¡ ¢ B C D § E G H I K L M N O ¤ ¥ P Q R S T U ¦ V X Y 

Thø tù s¾p xÕp cña c¸c dÊu thanh: 

Kh«ng dÊu, HuyÒn, Hái, Ng·, S¾c, NÆng 

VÝ dô víi ch÷ A: a µ ¶ · ¸ ¹ 
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Trong c¸c øng dông cña MS Word, muèn s¾p xÕp 1 danh s¸ch tiÕng ViÖt, tr−íc 
hÕt cÇn ph¶i t¹o 1 b¶ng b»ng c¸ch vµo Menu: Table/Insert/Table, ®iÒn sè cét vµ 
sè hµng (bá qua b−íc t¹o b¶ng míi nÕu ®· cã s½n b¶ng). Nh¾p chuét ®Ó con trá 
vµo cét cÇn s¾p (trong Word chØ cã thÓ s¾p theo cét, trong Excel cã thÓ s¾p theo 
cét hoÆc theo hµng). 

Sè thø tù Hä vµ tªn NghÒ nghiÖp 
1 §Æng Minh TuÊn LËp tr×nh viªn 
2 §ç §øc §−¬ng KS x©y dùng 
3 Ph¹m Tu©n Phi c«ng 
4 Ph¹m H¶i An TiÕp thÞ 

 

Trong MS Excel tr−íc khi s¾p xÕp cÇn chän vïng s¾p xÕp b»ng c¸ch b«i ®en vïng 
cÇn s¾p xÕp. 

Nh¾p chuét vµo thùc ®¬n VietkeyOF trong c¶ Word hoÆc Excel vµ chän Sap xep 
danh sach tieng Viet nh− h×nh d−íi ®©y: 
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Sau khi chän chøc n¨ng s¾p xÕp trong thùc ®¬n, mét cöa sæ Sort By Vietnamese 
sÏ xuÊt hiÖn. Trong cöa sæ nµy, cã thÓ chän: 

- Font nguån: lµ bé font ®ang hiÖn hµnh, ®ang ®−îc dïng trong v¨n b¶n. 

- Thø tù s¾p xÕp: cã thÓ chän thø tù s¾p xÕp hoÆc t¨ng dÇn hoÆc gi¶m dÇn.  

- XÕp theo tªn: c«ng cô nµy sÏ tù ®éng c¾t tõ cuèi lµ tªn chÝnh ®Ó xÕp, nÕu 
trïng sÏ tiÕp tôc xÕp theo hä vµ ®Öm cña tªn. NÕu bá thuéc tÝnh nµy th× 
c«ng cô s¾p xÕp sÏ x¾p theo thø tù tõ tr¸i qua ph¶i. 

- XÕp c¶ Header: c«ng cô nµy sÏ xÕp hay bá qua hµng ®Çu tiªn (tiªu ®Ò), 
kh«ng xÕp . 

Riªng trong MS Excel, c«ng cô s¾p xÕp cã giao diÖn kh¸c, vµ cho phÐp xÕp theo 
cét hoÆc xÕp theo hµng. Kh«ng nh÷ng thÕ c«ng cô s¾p xÕp trong MS Excel cßn 
cho phÐp xÕp víi 3 møc kh¸c nhau. 
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Sau khi s¾p xÕp b¶ng trªn sÏ ®−îc xÕp l¹i, c¸c d÷ liÖu kh¸c cïng hµng còng sÏ 
®−îc di chuyÓn theo nh− b¶ng sau. 

Sè thø tù Hä vµ tªn NghÒ nghiÖp 
4 Ph¹m H¶i An TiÕp thÞ 
2 §ç §øc §−¬ng KS x©y dùng 
3 Ph¹m Tu©n Phi c«ng 
1 §Æng Minh TuÊn LËp tr×nh viªn 
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III.5. ChuyÓn ®æi ch÷ hoa/ch÷ th−êng 

V× m· cña c¸c ch÷ hoa tiÕng ViÖt vµ ch÷ th−êng t−¬ng øng trong b¶ng m· 
Unicode/TCVN 6909 kh«ng c¸ch nhau 32 ®¬n vÞ nªn kh«ng thÓ dïng c¸c chøc 
n¨ng chuyÓn ch÷ hoa/ch÷ th−êng (Change Case - Shift+F3) trong c¸c øng dông 
Word/Excel/PowerPoint. TCVN6909/Unicode còng kh«ng cã font riªng cho ch÷ 
hoa vµ font riªng cho ch÷ th−êng nh− font ABC, do ®ã nÕu kh«ng cã c«ng cô 
chuyÓn ch÷ hoa ch÷ th−êng th× b¾t buéc ph¶i xo¸ ch÷ th−êng ®Ó gâ l¹i ch÷ hoa vµ 
ng−îc l¹i.  Tuy nhiªn trong c«ng cô cña Vietkey Office, c«ng cô chuyÓn ch÷ hoa 
vµ ch÷ th−êng ®· ®−îc tÝch hîp vµo Word/Excel/Powerpoint, ®Ó chuyÓn ®æi ch÷ 
hoa vµ ch÷ th−êng, tr−íc tiªn cÇn ph¶i thiÕt lËp b¶ng m· mÆc ®Þnh sÏ dïng trong 
so¹n th¶o v¨n b¶n. 
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Muèn chuyÓn mét ®o¹n text (v¨n b¶n) tõ ch÷ hoa thµnh ch÷ th−êng hoÆc ng−îc 
l¹i,  cÇn ph¶i chän ®o¹n text ®ã (b«i ®en b»ng chuét hay bµn phÝm), sau ®ã nh¾p 

chuét vµo biÓu t−îng  hoÆc chän môc Chuyen chu hoa/chu thuong trong 
menu VietkeyOffice, hoÆc còng cã thÓ dïng tæ hîp phÝm nãng lµ Alt-H, ®o¹n 
ch÷ b«i ®en sÏ ®−îc chuyÓn thµnh ch÷ th−êng, nÕu lµm tiÕp lÇn n÷a, ®o¹n ch÷ ®ã 
sÏ ®−îc chuyÓn thµnh ch÷ hoa. 

L−u ý: Trong MS Excel chØ chuyÓn ®æi ch÷ hoµ, ch÷ th−êng trong tõng « (Cell). 

III.6. ChuyÓn m· v¨n b¶n cho c¸c v¨n b¶n word /excel 
/powerpoint 
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ChuyÓn m· v¨n b¶n lµ mét chøc n¨ng quan träng trong bé Vietkey Office, bé 
chuyÓn m· nµy cho phÐp chuyÓn ®æi c¸c v¨n b¶n ®−îc so¹n th¶o trong c¸c øng 
dông Word, Excel, PowerPoint trong c¸c bé MS Office 97, 2000, XP. ¦u ®iÓm 
cña bé chuyÓn m· VKO lµ nã cho phÐp chuyÓn ®æi trung thµnh c¸c v¨n b¶n ®−îc 
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so¹n th¶o tõ h¬n 40 bé m·/Font ch÷ tiÕng ViÖt kh¸c nhau, gi÷ nguyªn ®−îc c¸c 
thuéc tÝnh (®Ëm, nghiªng, g¹ch ch©n, kiÓu d¸ng, kÝch th−íc font) cña v¨n b¶n. Bé 
chuyÓn m· còng cho phÐp chuyÓn ®æi c¸c ®o¹n ch÷ trong 11 vïng kh¸c nhau, kÓ 
c¶ ®å ho¹, b¶ng biÓu, header/footer... 

- §Ó thùc hiÖn viÖc chuyÓn m· 1 v¨n b¶n, tr−íc tiªn cÇn më v¨n b¶n ®ã 
b»ng ch−¬ng tr×nh so¹n th¶o t−¬ng øng (Word, Excel hoÆc PowerPoint). 

- Nªn l−u v¨n b¶n gèc tr−íc khi chuyÓn m·  sang 1 th− môc kh¸c ®Ó l−u tr÷. 

- Nh¾p chuét vµo  môc Chuyen ma/font van ban trong Menu cña 

VietkeyO2.1 hoÆc nót  trong thanh c«ng cô cña VietkeyO2.1, khi ®ã 
cöa sæ Vietkey Code Conveter xuÊt hiÖn. 

- Font nguån:  lµ bé m· hoÆc bé font t−¬ng øng cÇn chuyÓn m· (VÝ dô 
TCVN3-ABC hoÆc VNI...), khi b¾t ®Çu khëi ®éng,  c«ng cô chuyÓn m· sÏ 
cè g¾ng ®o¸n nhËn bé font/m· ®ang ®−îc dïng nh»m gióp ng−êi sö dông 
khái lóng tóng khi chän ®óng Font nguån trong sè h¬n 40 bé font kh¸c 
nhau. Trong 1 sè tr−êng hîp, kh«ng ®ñ th«ng tin,  c«ng cô chuyÓn m· sÏ 
®o¸n kh«ng ®óng b¶ng m· ®ang dïng, khi Êy ng−êi dïng cã thÓ chän l¹i 
cho ®óng trong danh s¸ch Font nguån b»ng c¸ch nh¾p chuét vµo  nót  
cña danh s¸ch nµy. 
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o L−u ý: trong 1 sè tr−êng hîp cã thÓ c¨n cø theo tªn font ®Ó ®o¸n 
nhËn ra bé Font hoÆc bé m· nguån: 
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 C¸c font b¾t ®Çu b»ng .Vn (VÝ dô .VnTime, .VnTimeH, 
.VnArial, .VnArialH) lµ bé font TCVN3-ABC. 

 C¸c font b¾t ®Çu b»ng VNI- (vÝ dô VNI-Times... ) lµ bé font 
VNI-WIN. 

 C¸c Font b¾t ®Çu b»ng Vn (VÝ dô VnTimes, VnArial...) 
th−êng lµ bé font BK. HCM 1. 

 C¸c Font b¾t ®Çu b»ng Vn nh−ng kÕt thóc lµ sè 2 (VÝ dô 
VnTimes2, VnArial2...) th−êng lµ bé font BK. HCM 2. 

 C¸c font ¸nh Min, Minh Qu©n, Heo may, Hoµng YÕn, U 
hoµi lµ bé Font VISCII. 

 C¸c font b¾t ®Çu b»ng VN (VÝ dô VNtimes new roman, 
VNmonotype corsiva Italic...) th−êng lµ bé font Vietware_X 
hoÆc font VNU. 

 C¸c font b¾t ®Çu b»ng VN. (VÝ dô VN.Time, VN.Arial...) lµ 
bé font Vietkey 2.x. 

 C¸c font b¾t ®Çu b»ng VPS (VÝ dô VPS An Giang, VPS 
Nghe An...) lµ bé font VPS. 

- Font ®Ých: lµ bé m·/font cÇn chuyÓn ®Õn, muèn chuyÓn vÒ font 
Unicode/TCVN 6909 h·y chän  VN Unicode1. 

- ChuyÓn Font: thuéc tÝnh nµy cho phÐp chuyÓn lu«n c¶ tªn font thµnh tªn 
font míi t−¬ng øng trong v¨n b¶n ®Ých. 

- §o¸n m·/Font: nót nµy  cho phÐp tù ®éng ®o¸n m·/font cña v¨n b¶n hiÖn 
hµnh (trong 1 sè tr−êng hîp nh− thiÕu th«ng tin, chøc n¨ng nµy sÏ ®o¸n 
kh«ng ®óng). 
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- Ph¹m vi: trong môc nµy, c«ng cô chuyÓn m· cho phÐp chuyÓn toµn bé v¨n 
b¶n, hay trong vïng lùa chän (b«i ®en b»ng chuét hay bµn phÝm), hoÆc tõ 
1 vÝ trÝ bÊt kú vÒ ®Çu hoÆc cuèi v¨n b¶n. 

- L−u ý: trong 1 sè tr−êng hîp nÕu cã môc lôc tù ®éng, hoÆc b¶ng biÓu 
phøc t¹p, bé c«ng cô chuyÓn m· cã thÓ lµm viÖc kh«ng æn ®Þnh th× h·y 
chuyÓn c¸c ®èi t−îng nµy sang 1 v¨n b¶n míi, sau khi chuyÓn xong phÇn 
ch÷ (text) råi míi copy vÒ v¨n b¶n ®Ých. 
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IV. chuyÓn m· cho c¸c trang Web 

IV.1. Giíi thiÖu chung 

IV.2. Cµi ®Æt c«ng cô chuyÓn m· tiÕng ViÖt cho c¸c 
trang Web 

C«ng cô chuyÓn m· cho c¸c trang Web (cho 1 trang Web hay toµn bé c¶ c¸c th− 
môc) lµ VKCNVR.EXE cã kÝch th−íc kho¶ng 160KB, còng nh− bé gâ Vietkey 
rót gän, kh«ng cÇn ph¶i cµi ®Æt, copy ch−¬ng tr×nh vÒ mét th− môc bÊt kú vµ nh¾p 
chuét vµo biÓu t−îng cña VKCNVR.EXE, ch−¬ng tr×nh sÏ ®−îc kÝch ho¹t. 

C«ng cô nµy cã kh¶ n¨ng ch¹y trªn c¸c hÖ ®iÒu hµnh Windows 95/98, Windows 
NT, Windows 2000, Windows XP. 

IV.3. H−íng dÉn sö dông chuyÓn m· c¸c trang Web 

C«ng cô chuyÓn m· cho c¸c trang Web: Vkconvr.exe, cã kh¶ n¨ng chuyÓn m· 
cho tõng trang Web hay cïng 1 lóc chuyÓn nhiÒu trang Web trong 1 th− môc vµ 
cã kh¶ n¨ng quÐt tiÕp c¸c th− môc con ®Ó chuyÓn m·. 

Ch−¬ng tr×nh cã kh¶ n¨ng chuyÓn c¸c tÖp HTML (c¸c trang Web) tõ h¬n 40 b¶ng 
m· tiÕng ViÖt kh¸c nhau sang bé m· Unicode/TCVN 6909 mµ vÉn gi÷ nguyªn 
c¸c ®Þnh d¹ng vµ c¸c ®èi t−îng cã trªn trang Web. §Çu ra cã thÓ chuyÓn thµnh 
c¸c khu«n d¹ng UCS2 (m· cã ®é dµi 16-Bit) hoÆc d¹ng UTF-8 (d¹ng biÕn ®æi c¸c 
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ký tù 16-Bit thµnh chuçi c¸c ký tù 8-Bit), ®ång thêi còng cã thÓ l−u c¸c trang 
Web thµnh d¹ng 7-Bit kh¸c. 

Tr−íc khi chuyÓn m·, nªn l−u c¸c trang gèc ra 1 th− môc kh¸c ®Ó cã thÓ sö dông 
vÒ sau. 

Ch−¬ng tr×nh cã kh¶ n¨ng chän file theo h×nh thøc kÐo-th¶ (drag-drop) b»ng 
chuét khi nh¾p chuét vµo nót ,  
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Sau ®ã cã thÓ më Windows Explore ®Ó chän tÖp (File) vµ dïng chuét kÐo vµo 
cöa sæ Vietkey Web Conveter. 

L−u ý: Trong mét sè tr−êng hîp nÕu c¸c trang Web kh«ng hiÓn thÞ ®Çy ®ñ tªn 
phÇn më réng (htm, html) th× ch−¬ng tr×nh sÏ kh«ng chuyÓn  m· ®óng. Trong 
Windows Explore->Tools->Folder Options->View bá chøc n¨ng Hide 
Extension for know file type. 
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V. Bé th− viÖn lËp tr×nh xö lý tiÕng ViÖt 

- Cã trªn 20 hµm (aPi) c¬ b¶n cho phÐp ®¸p øng hÇu nh− tÊt c¶ c¸c nhu cÇu 
xö lý tiÕng ViÖt. 

- Hç trî cho hÇu nh− tÊt c¶ c¸c ng«n ng÷ lËp tr×nh: Visual Basic, Visual C, 
Foxpro, SQL Server, MS access, Delphi… 

- Kh«ng cÇn cµi ®Æt, ®i kÌm theo bé Vietkey Office. 

long VK_Convert(char *str_source, char *str_dest); 

ByTe VK_Code2Code(ByTe id_source, ByTe id_dest); 

long VK_VN2unicode(char *str_source, LPWSTR str_dest); 

long VK_unicode2VN(LPWSTR str_source, char *str_dest ); 

BooL VK_isuniCharup (long tch); 

long VK_loweruniChar(long tch); 

long VK_upperuniChar(long tch); 

ByTe VK_defaultCode (ByTe id_code); 

long VK_upperStr (char *str_source); 

long VK_lowerStr (char *str_source); 

long VK_vn2str7bit(ByTe mode,char *str_source, 

char *str_dest); 

long VK_strcmp(char *str_source, char *str_dest); 

long VK_convertFont(char *font_source, char *font_dest); 

ByTe VK_run (ByTe cmd); 
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VI. C¸c c©u hái th−êng gÆp 

VI.1. Lµm g× khi gÆp khã kh¨n trong viÖc dïng Vietkey?  

- Nghiªn cøu tµi liÖu h−íng dÉn sö dông. 

- T×m thªm th«ng tin trªn trang Web: http://www.vietkey.net  

- T×m c¸c vÊn ®Ò trong phÇn c¸c c©u hái th−êng gÆp, trong diÔn ®µn cña 
http://www.vietkey.net . 

- Göi Email cho nhãm ph¸t triÓn Vietkey Group: unicode@vietkey.net, 
vietkhang1@hn.vnn.vn, vietkhang2@hcm.vnn.vn hoÆc trong tr−êng hîp 
rÊt cÇn thiÕt cã thÓ göi cho t¸c gi¶ dangtuan@hn.vnn.vn. 

- Gäi ®iÖn tho¹i cÇn t− vÊn hç trî cho c¸c chi nh¸nh t¹i Hµ Néi vµ Tp Hå 
ChÝ Minh, ®Þa chØ cô thÓ cã trªn hép s¶n phÇm hoÆc trªn Website. 

 

VI.2. C¸c b¶n n©ng cÊp vµ c¸c th«ng tin míi vÒ s¶n phÇm 
cã ë ®©u? 

Trªn Website http://www.vietkey.net  hoÆc Website cña c«ng ty Vietkhang. 

 

VI.3.  T¹i sao khi gâ tiÕng ViÖt, ch÷ cã dÊu ®«i khi bÞ 
ChÌn 1 ký tù trèng?  
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Nguyªn nh©n: Trong c¸c øng dông cña Microsoft (Word), cã mét sè tÝnh n¨ng 
®−îc dïng cho ng÷ ph¸p tiÕng Anh nªn khi gâ tiÕng ViÖt sÏ cã sù xung ®ét vÒ 2 
ng«n ng÷ nµy, do ®ã cÇn ph¶i t¾t c¸c tÝnh n¨ng tù ®éng hiÖu chØnh theo ng÷ ph¸p 
tiÕng Anh: 

Kh¾c phôc: Më MS Word, vµo Tools/Option/Edit bá dÊu check ë môc use 
smart cut & paste  ®Ó kh¾c phôc lçi dÊu c¸ch. 

VI.4.  T¹i sao trong mét sè ch÷ tiÕng ViÖt ch÷ ‘i’  biÕn 
thµnh ch÷ ‘I’? 

Nguyªn nh©n: Trong tiÕng Anh, ®¹i tõ ng«n thø nhÊt lµ ‘I’ lu«n ®Ó ë d¹ng viÕt 
hoa, nÕu viÕt ch÷ ‘i’, Word tù ®éng hiÖu chØnh theo ng÷ ph¸p tiÕng Anh thµnh ‘I’. 

C¸ch kh¾c phôc: Më Word, vµo Tools/AutoCorrect vµ bá dÊu check trong môc 
nµy Replace text as you type hoÆc trong xo¸ môc i->I trong danh s¸ch thay thÕ. 

VI.5.  Lçi m¸y in khi in ch÷ Unicode? 

 

Nguyªn nh©n: Mét sè m¸y in cã Driver kh«ng t−¬ng thÝch víi Unicode, phÇn xö 
lý in Ên cña mét sè phiªn b¶n cña c¸c phÇn mÒm nµy kh«ng t−¬ng hîp víi 
Unicode. Mét sè m¸y in d−íi ®©y cã thÓ cã vÊn ®Ò in Ên víi v¨n b¶n Unicode: 

Canon BubbleJet BJ-C600, 4000, 4200, 4500, 4550, v 3.40  

Canon Multipass 2500 3.40  

Epson Color 500  

Epson Stylus Color, v 2.x  

Epson Stylus Pro / XL v. 2.11BE  
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HP 1100, 1200 

HP Color LaserJet 5 PCL, printer driver version F 1.300  

HP DeskJet 1600C, printer driver version 4.20  

HP LaserJet 4 PCL, printer driver version 3.78  

HP LaserJet 6P, standard printer driver  

Okidata 4 laser printer ... 

Kh¾c phôc:  

- N©ng cÊp Printer Driver míi nhÊt cã thÓ ®−îc tõ Website cña nhµ s¶n xuÊt 
vÝ dô http://www.hp.com. 

- §èi víi mét sè chñng lo¹i m¸y in (HP1100):  

o vµo Start->Setting->Printer->M¸y in cña b¹n. 

o Chän m¸y in, vµo môc Properties -> Details -> Spool Setting... 

 

 

 

 

 

 

 

 

 

 

o Chän Spool Setting... -> Spool data format:  RAW. 

- M¸y in Postcripts: 
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o Vµo Properties, chän download soft font or download outline 
font. 

- M¸y in HP DeskJet 1600C: 

o Vµo Properties->Detail->Setup->Colorsmart Setup->Advanced 
chän Use LaserJet III font scaling->OK.  

- Mét sè m¸y in kh¸c (HP LaserJet 4 Series PCL...): 

o Properties -> Fonts -> chän "Always use True Type Fonts" 

o HoÆc chän Print True Type Fonts as graphic. 

o Cã thÓ dïng phÇn mÒm FinePrint, vµo http://www.google.com gâ 
tõ FinePrint ®Ó t×m ra c¸c ®Þa chØ t¶i xuèng. 

- §èi víi MS Office 97 cã thÓ kh¾c phôc b»ng c¸ch söa ®æi gi¸ trÞ trong 
Registry (Word vµ Excel): 

o Start->Run ch¹y regedit 

o Trong môc  

    
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Excel\M
icrosoft Excel thªm môc míi vµ gâ NoWideTextRendering trong « 
gi¸ trÞ 4. 

o Trong môc: 

 
HKEY_CURRENT_USER\Software\Microsoft\Office\8.0\Word\O
ptions  thªm môc míi NoWideTextPrinting vµ trong Value Data 
nhËp gi¸ trÞ 1. 

 

VI.6.  NÕu m¸y tÝnh kh«ng cã æ ®äc ®Üa CD cÇn ph¶i lµm 
thÕ nµo? 
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- §Õn mét m¸y tÝnh kh¸c cã æ ®Üa CD vµ æ ®Üa mÒm 1.44, copy tõng th− 
môc Disk1,...Disk7 trong ®Üa CD vµo tõng ®Üa mÒm. Sau ®ã tiÕn hµnh cµi 
tõ æ ®Üa mÒm. 

- T¶i xuèng (Download) tõ ®Þa chØ http://www.vietkey.net hoÆc 
http://www.vietkey.com. 

 

VI.7.  Trong th− tÝn ®iÖn tö muèn dïng tiÕng ViÖt 
Unicode cÇn ph¶i lµm g×? 

- §èi víi tr×nh so¹n th− ®iÖn tö phæ th«ng Outlook Express hoÆc MS 
Outlook, khi so¹n mét th− míi cÇn lµm c¸c b−íc sau: 

o Më Outlook chän New, 

o Vµo Format chän HTML, 

o Vµo Format->Enconding  chän Unicode(UTF-8). 

 

- Víi th− nhËn ®−îc hiÓn thÞ tiÕng ViÖt Unicode kh«ng ®óng: 

o Vµo Format->Enconding  chän Unicode(UTF-8) hoÆc Western 
European (ISO  hoÆc Windows). 

VI.8. C¸ch so¹n th¶o c¸c trang Web Unicode tiÕng ViÖt 

- C¸c tr×nh so¹n th¶o Web phæ th«ng hç trî Unicode tiÕng ViÖt: FrontPage 
2000, FrontPage XP. 

- C¸c tr×nh so¹n th¶o Web kh¸c nh− Dreamwaever tuy kh«ng hç trî 
Unicode nh−ng vÉn cã thÓ so¹n th¶o ®−îc c¸c trang Web tiÕng ViÖt 
Unicode. Dïng bé Vietkey ®Çy ®ñ, chän m· tiÕng ViÖt lµ Unicode1 UTF-
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8 (sè 41) hoÆc Unicode1 UCS2 (m· sè 42)  tuy hiÓn thÞ trong tr×nh so¹n 
th¶o kh«ng ®óng tiÕng ViÖt, nh−ng c¸c file HTML kÕt qu¶ vÉn hiÓn thÞ 
®óng tiÕng ViÖt. 

- Nªn sö dông ®Þnh d¹ng Unicode UTF-8 v× ®Þnh d¹ng nµy cho phÐp t−¬ng 
thÝch tèt h¬n víi c¸c m«i tr−êng 8-Bit, nÕu dïng ®Þnh d¹ng UCS2, hoÆc 
Windows 1252 th× cã thÓ mét sè tr×nh duyÖt, hoÆc mét sè m«i tr−êng Unix 
sÏ kh«ng ®äc ®−îc. 

- Tr−íc khi so¹n th¶o mét trang Web míi, b−íc ®Çu tiªn nªn lµm lµ chuyÓn 
®Þnh d¹ng vÒ UTF-8.  Trong FrontPage, më trang míi b»ng lÖnh New 
nh¾p chuét vµo nót HTML ë d−íi ®Ó xem source cña trang Web: 

<meta http-equiv="Content-Type" content = "text /html; 
charset = windows-1252"> 

o Trong dßng trªn thay Windows-1252 b»ng UTF-8. 

o Sau khi chÕ ®é nµy ®−îc thiÕt lËp, khi chuyÓn v¨n b¶n tõ MS Word 
sang ProntPage, ®o¹n text sÏ ®−îc chuyÓn tù ®éng sang d¹ng UTF-
8. 

VI.9. ThiÕt lËp chÕ ®é hiÓn thÞ Unicode cho c¸c tr×nh 
duyÖt Web? 

- Tr−íc tiªn muèn hiÓn thÞ ®−îc tiÕng ViÖt Unicode trong m¸y tÝnh cÇn ph¶i 
cµi bé Font ch÷ Unicode (cã trong bé ®Üa cµi ®Æt). 

- Tr×nh duyÖt Web ph¶i cã c¸c phiªn b¶n Internet Explore 5.0 trë lªn hoÆc 
Netscape 4.7 trë lªn. 

- Th«ng th−êng tr×nh duyÖt Web sÏ tù ®éng hiÓn thÞ ®óng tiÕng ViÖt 
Unicode cã b¶ng m· ®óng theo sù chØ ®Þnh cña tr−êng Meta charset trong 
trang Web. Tuy nhiªn trong mét sè trang Web hoÆc kh«ng cã tr−êng chØ 
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®Þnh nµy hoÆc chØ ®Þnh sai. Do ®ã trong nh÷ng tr−êng hîp nµy cÇn ph¶i chØ 
®Þnh l¹i b»ng tay: Më IE, View->Enconding  chän Unicode(UTF-8) hoÆc 
Western European (ISO  hoÆc Windows). 

VI.10. So¹n th¶o tiÕng ViÖt Unicode trong mét sè phÇn 
mÒm kh¸c? 

- Emacs 21.2:  

o Vietkey chän b¶ng m· UTF-8. 

o Trong Emacs ®Æt keyboard-coding-system lµ uTF-8.  

 BÊm tæ hîp phÝm: C-x ReT k utf-8. C¸ch nµy chØ cã t¸c dông 
trong mét phiªn lµm viÖc cña emacs. 

 Ch¹y lÖnh customize cña emacs: M-x customize. Sau ®ã chän 
environment - i18n - Mule - Keyboard Coding System, 
®Æt Keyboard Coding System lµ uTF-8. Lùa chän nµy sÏ 
lu«n lu«n cã t¸c dông khi khëi ®éng emacs.  

- GVim: 

o Vietkey chän b¶ng m· tiÕng ViÖt lµ UTF-8. 

o Vµo file _vimrc ë th− môc gèc cña gVim (th−êng lµ c:\vim) thªm 
c¸c dßng lÖnh: 

Setencoding=unicode 

set guifont=courier_new 
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- C¸c phÇn mÒm ®å ho¹:  

o PhotoShop tõ phiªn b¶n 7.0 hç trî tiÕng ViÖt Unicode. 

o CorelDRAW hiÖn nay ch−a hç trî Unicode. 

VI.11. Unicode trong c¸c m«i tr−êng lËp tr×nh 

- Bé Visual Studio 97 ch−a hç trî Unicode mét c¸ch hoµn chØnh. Trong c¸c 
tr×nh so¹n th¶o kh«ng cho phÐp gâ trùc tiÕp Unicode. Tuy nhiªn ®èi víi 
ng«n ng÷ lËp tr×nh C, C++, cã thÓ dïng Vietkey ®Ó nhËp c¸c ®o¹n Text 
Unicode b»ng c¸ch chän b¶ng m· sè 43 (Unicode C Style). 

- C¸c Control chuÈn (Menu, Combo box, Listbox...) th−êng kh«ng l−u tr÷ vµ 
hiÓn thÞ ®−îc c¸c d÷ liÖu text Unicode. §Æc biÖt trong m«i tr−êng 
Windows 95/98 lµ m«i tr−êng phæ biÕn ë ViÖt Nam th× viÖc hç trî lËp 
tr×nh øng dông Unicode rÊt h¹n chÕ. 

- C¸c Controls trong m«i tr−êng Windows NT (2000, XP) hç trî Unicode 
tèt tuy nhiªn c¸c øng dông Unicode dÞch trªn m«i tr−êng nµy l¹i kh«ng 
ho¹t ®éng ®−îc trªn Windows 9x. §Ó gi¶i quyÕt vÊn ®Ò nµy cã th dïng bé 
Vietkey Controls cho phÐp hiÓn thÞ Unicode trong c¸c Control chuÈn trong 
2 m«i tr−êng Win-32, kÓ c¶ trªn hÖ ®iÒu hµnh Windows 9x (xem phÇn 
mÒm ATOL : www.vietkey.net).  

VI.12. Unicode lµ g×? 

Unicode lµ viÕt t¾t cña tõ Universal Code, tøc lµ bé m· v¹n n¨ng, cã thÓ dïng ®Ó 
m· ho¸ tÊt c¶ c¸c ng«n ng÷ chÝnh trªn toµn thÕ giíi (trong ®ã cã tiÕng ViÖt), ®−îc 
dïng chñ yÕu trong trao ®æi hiÓn thÞ d÷ liÖu trong c¸c hÖ thèng c«ng nghÖ th«ng 
tin. Unicode cßn lµ céng ®éng cña mét sè c«ng ty hµng ®Çu trong lÜnh vùc c«ng 
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nghÖ th«ng tin nh− Microsoft, IBM, Sun... ®−îc thµnh lËp tõ n¨m 1991 nh»m t¹o 
ra mét bé m· dïng chung cho toµn thÕ giíi. Song song víi tæ chøc Unicode cßn 
cã tæ chøc ISO(Tæ chøc chuÈn quèc tÕ chÝnh thèng) còng nghiªn cøu mét bé m· 
®a ng÷ dïng trong CNTT lµ ISO /IEC 10646. Unicode vµ ISO tõ n¨m 1993 ®· 
thèng nhÊt cïng nhau ph¸t triÓn vµ ®ång nhÊt 2 bé m· ë miÒn 16-Bit. Unicode lµ 
bé m· 16-Bit (cã 65.536 « m·), cßn ISO 10646 lµ bé m· 32-Bit (cã 
4.294.967.296 « m·). Phiªn b¶n míi nhÊt cña UNICODE lµ phiªn b¶n 3.2 (trong 
®ã cã 143 ký tù tiÕng ViÖt Quèc ng÷ vµ  9299 ch÷ N«m), Phiªn b¶n míi nhÊt cña 
ISO lµ ISO/IEC 10646-1:2000. 

VI.13. UTF-8 lµ g×? 

UTF-8 lµ viÕt t¾t cña côm tõ Unicode Transformation Format 8-Bit. Lµ d¹ng 
chuyÓn ®æi Unicode dïng ®Ó chuyÓn ký tù 16-Bit Unicode thµnh chuçi ký tù 8-
Bit t−¬ng ®−¬ng. V× ®a phÇn c¸c øng dông, c¸c m«i tr−êng hiÖn hµnh (kÓ c¶ 
Unix-Linux) th−êng chØ hç trî c¸c d÷ liÖu 8-Bit, nªn ®Ó t¨ng kh¶ n¨ng t−¬ng 
thÝch víi c¸c hÖ thèng cò trong nhiÒu tr−êng hîp ng−êi ta l−u ®o¹n d÷ liÖu 
Unicode thµnh d¹ng 8-Bit. 

UTF-8 ®−îc dïng rÊt phæ biÕn trong Internet, hÖ ®iÒu hµnh Unix-Linux vµ c¸c hÖ 
qu¶n trÞ c¬ së d÷ liÖu nh− Oracle... 

VI.14. TiÕng ViÖt ®−îc bè trÝ nh− thÕ nµo trong chuÈn 
Unicode? 

Tõ n¨m 1993, tiÕng ViÖt ®· ®−îc bè trÝ ®Çy ®ñ tÊt c¶ c¸c con ch÷ dùng s½n, tæ hîp 
vµ c¶ c¸c ký tù tæ hîp dÊu thanh vµ tæ hîp dÊu nguyªn ©m. Mét con ch÷ tiÕng 
ViÖt trong mét sè tr−êng hîp cã thÓ ®−îc biÓu diÔn ë 3 d¹ng kh¸c nhau: dùng 
s½n, tæ hîp, chÝnh t¾c (Canonical). D¹ng tæ hîp lµ d¹ng cña c¸c nguyªn ©m tæ hîp 
víi c¸c ký tù dÊu thanh, d¹ng chÝnh t¾c lµ d¹ng tæ hîp cña c¸c nguyªn ©m 
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(a,e,u,o) víi c¸c ký tù dÊu nguyªn ©m (r©u, tr¨ng, mò) vµ ký tù dÊu thanh. VÝ dô 
ch÷ ‘õ’ cã thÓ ®−îc biÓu diÔn nh− sau: 

 Tæ hîp ch÷ Chuçi m· Hex 

Dùng s½n Õ 1EAB 

Tæ hîp − +` 01B0 + 0300  

ChÝnh t¾c u + ’ + ` 0075 + 031B + 0300  

 

Trong b¶ng m· Unicode c¸c con ch÷ ViÖt kh«ng ®−îc xÕp liªn tôc liÒn nhau 
trong mét vïng mµ n»m r¶i r¸c trong 5 vïng c¸ch nhau: Latin-1, Latin më réng 
A, La tin më réng B, Vïng c¸c ký tù tæ hîp, Latin më réng thªm. Ch÷ hoa vµ ch÷ 
th−êng trong mét sè tr−êng hîp ®−îc xÕp c¹nh nhau 1 c¸ch t−¬ng øng mµ kh«ng 
c¸ch nhau 1 kho¶ng 32 gi¸ trÞ nh− trong c¸c b¶ng m· ISO 8859 vµ trong nhiÒu 
tr−êng hîp l¹i c¸ch nhau víi c¸c kho¶ng cã gi¸ trÞ hoµn toµn kh¸c nhau. 

VI.15. T¹i sao tiÕng ViÖt l¹i kh«ng ®−îc xÕp vµo mét vïng 
liªn tôc?  

Mét trong nh÷ng nguyªn t¾c cña Unicode lµ tÝnh t−êng minh vµ tÝnh kh«ng d− 
thõa, tøc lµ mét h×nh ch÷ chØ cã mét m· duy nhÊt ®Ó bé m· cã tÝnh nhÊt qu¸n, 
tÝnh ®¬n trÞ vµ còng ®Ó tiÕt kiÖm kh«ng gian m·. Cã nhiÒu h×nh ch÷ cã thÓ xuÊt 
hiÖn trong nhiÒu ng«n ng÷, vÝ dô ch÷ ‘Ì’ cã trong c¶ tiÕng ViÖt, tiÕng Ph¸p vµ 
tiÕng TiÖp, nh− vËy c¸c ng«n ng÷ nµy ph¶i dïng chung mét m·, do ®ã kh«ng thÓ 
cã 3 ch÷ ‘Ì’ cho 3 ng«n ng÷ kh¸c nhau. §©y chÝnh lµ nguyªn nh©n t¹i sao c¸c ch÷ 
ViÖt l¹i kh«ng ®−îc xÕp liªn tôc cïng nhau. 
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VÒ vÊn ®Ò s¾p xÕp, nÕu c¸c ch÷ ®−îc xÕp liªn tôc th× t−ëng chõng viÖc s¾p xÕp sÏ 
®−îc dÔ dµng h¬n, tuy nhiªn trªn thùc tÕ kh«ng ph¶i nh− vËy, tiÕng ViÖt kh«ng 
thÓ chØ dùa vµo gi¸ trÞ m· cña con ch÷ ®Ó s¾p xÕp mµ ph¶i dïng thuËt to¸n t−¬ng 
®èi phøc t¹p ®Ó s¾p, do ®ã mét khi ®· ph¶i dïng thuËt to¸n riªng th× viÖc c¸c con 
ch÷ cã ë liªn nhau hay kh«ng, còng kh«ng anh h−ëng l¾m ®Õn thuËt to¸n s¾p xÕp. 
(vÝ dô ‘a’ ®øng tr−íc ‘µ’ nh−ng ‘µ’ l¹i ®øng tr−íc ‘an’). 

VI.16.  ¦u ®iÓm chÝnh cña Unicode lµ g×? 

¦u ®iÓm chÝnh cña Unicode lµ kh«ng gian m· réng h¬n 256 lÇn so víi kh«ng 
gian m· cña c¸c bé m· 8-Bit, do ®ã nã cho phÐp m· ho¸ tÊt c¶ c¸c ng«n ng÷ 
chÝnh trªn thÕ giíi, cho phÐp tiÕng ViÖt héi nhËp víi tÊt c¶ c¸c ng«n ng÷ kh¸c 
trªn thÕ giíi. TiÕng ViÖt trong Unicode cã ®Çy ®ñ tÊt c¶ c¸c con ch÷, c¶ hoa vµ 
th−êng, ®ång thêi kh¾c phôc ®−îc triÖt ®Ó c¸c lçi tranh chÊp víi ký tù ®iÒu khiÓn 
cña c¸c bé m· 8-Bit, vÝ dô kh¾c phôc hiÖn t−îng mÊt ch÷ ‘−’, ‘¬’,’¶’... 

C¸c c«ng ty lín hµng ®Çu thÕ giíi vÒ CNTT ®Òu cam kÕt hç trî Unicode, 
Unicode/ISO01646 hiÖn vµ ®ang lµ xu thÕ cña c¸c chuÈn vµ c«ng nghÖ míi. 

VI.17.  Nh−îc ®iÓm chÝnh cña Unicode lµ g×? 

Do lµ bé m· 16-Bit nªn kh«ng gian nhí vµ trªn ®Üa cøng cña c¸c v¨n b¶n ®−îc 
so¹n b»ng Unicode sÏ lín h¬n c¸c bé m· 8-Bit. 

Nh−îc ®iÓm chÝnh lµ c¸c øng dông hç trî Unicode ch−a nhiÒu, tuy nhiªn trong 
t−¬ng lai kh«ng xa c¸c øng dông sÏ ®−îc chuyÓn sang hç trî Unicode, còng 
gièng nh− viÖc chuyÓn tõ 7-Bit sang 8-Bit tõ nh÷ng n¨m 80. Vµ trªn thùc tÕ c¸c 
øng dông phæ th«ng vµ c¸c hÖ ®iÒu hµnh phæ th«ng nhÊt ®· ®Òu hç trî Unicode. 
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VI.18. C¸c file Unicode cã kÝch th−íc tõ 2 ®Õn 256 lÇn so 
víi 8-Bit? 

Kh«ng ®óng, chØ trong tr−êng hîp tÊt c¶ c¸c con ch÷ ®Òu ®−îc m· ho¸ b»ng 1 sè 
16-Bit th× file Unicode sÏ lín h¬n gÊp ®«i vµ dung l−îng chuyÓn t¶i trªn ®−êng 
truyÒn sÏ lín h¬n gÊp ®«i. Tuy nhiªn trªn thùc tÕ c¸c v¨n b¶n ®−îc so¹n b»ng 
Word hay c¸c trang Web Unicode, chØ c¸c ch÷ tiÕng ViÖt cã dÊu míi ®−îc l−u ë 
d¹ng 16-Bit trong khi c¸c ch÷ ë vïng 7-Bit th× th−êng ®−îc gi÷ nguyªn do ®ã 
kh«ng ph¶i bao giê kÝch th−íc còng t¨ng lªn gÊp ®«i. Theo c¸c phÐp thèng kª th× 
th«ng th−êng c¸c file Unicode cã kÝch th−íc t¨ng lªn kho¶ng 25% so víi bé m· 
8-Bit TCVN3 vµ hÇu nh− kh«ng t¨ng so víi bé m· VNI. 

VI.19. T¹i sao kh«ng thÓ gâ ®−îc Unicode trong mét sè 
øng dông? 

(AutoCad, Foxpro, CorelDRAW, QuarkXpress, VB...) 

Mét trong nh÷ng ®iÓm kh¸c biÖt lín nhÊt gi÷ bé font Unicode vµ c¸c bé font 8-
Bit hiÖn hµnh lµ chØ cã øng dông nµo hç trî Unicode th× míi hiÓn thÞ vµ nhËp 
®−îc ch÷ Unicode. C¸c øng dông nªu ë trªn do kh«ng hç trî Unicode nªn kh«ng 
thÓ gâ ®−îc tiÕng ViÖt Unicode trong c¸c øng dông nµy. Tuy nhiªn trong t−¬ng 
lai kh«ng xa c¸c øng dông nµy sÏ ®−îc n©ng cÊp ®Ó cã thÓ hç trî  Unicode.  

VI.20. Muèn sö dông Unicode ph¶i n©ng cÊp m¸y tÝnh lªn  
Windows2000? 

Kh«ng nhÊt thiÕt, nÕu sö dông bé gâ Vietkey2000 Full th× cã thÓ gâ tiÕng ViÖt 
Unicode víi 9 kiÓu gâ phæ th«ng: Telex, Vni, BkTPHCM...víi Windows 95 vµ 
MS Office97. 
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C¸c hÖ ®iÒu hµnh míi: Windows 2000/ME/XP ®Òu ®· cã s½n c¸c font Unicode 
tiÕng ViÖt, sau khi cµi bé MS Office 2000, IE5 th× c¸c font Unicode còng ®−îc tù 
®éng cµi ®Æt trong hÖ thèng ngay c¶ ®èi víi hÖ ®iÒu hµnh Windows9x. §èi víi 
c¸c hÖ ®iÒu hµnh cò th× cÇn ph¶i cµi font Unicode th«ng qua bé cµi ®Æt 
Vietkey2000 Full Version. 
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VII. Phô lôc 

VII.1. §Þa chØ liªn hÖ 

Mäi th¾c m¾c, hái ®¸p, ®ãng gãp ý kiÕn cho c¸c c«ng cô xö lý tiÕng ViÖt 
Unicode/TCVN 6909 xin liªn hÖ víi nhãm ph¸t triÓn phÇn mÒm øng dông: 

Vietkey Group, Vietkhang JSC. 

Hµ Néi: 32 Hµng Cãt,  Hµ Néi,  +84(4) 8267593,  

TP Hå ChÝ Minh:  155 B4 S− V¹n H¹nh (nèi dµi), QuËn 10, +84(8)8640401. 

Email: 

unicode@vietkey.net 
vietkhang1@hn.vnn.vn 
vietkhang2@hcm.vnn.vn 

 

Website: 

 http://www.vietkey.net  
 
HoÆc cã thÓ download phÇn mÒm trªn c¸c Website 
 
 http://www.itvietnam.gov.vn 
 http://www.moste.gov.vn  
 



PhÇn mÒm hç trî xö lý tiÕng viÖt unicode / tcvn 6909                                                         T rang  64 

 

Vietkey group,     Email: unicode@vietkey.net,   Website: http://www.vietkey.net, 84-4-8267593 

VII.2. T¸c gi¶ 

KS. §Æng Minh TuÊn,  Tr−ëng phßng tÝch hîp hÖ thèng, ViÖn Tù ®éng ho¸. 

- T¸c gi¶ bé gâ ABC, Vietkey, Vietkey Office. 

- Biªn so¹n dù th¶o ®Çu tiªn cho tiªu chuÈn TCVN 6909. 

- Tr−ëng nhãm Vietkey Group víi c¸c s¶n phÈm kh¸c: 

o VKDataTools: Bé chuyÓn m· tiÕng ViÖt (Unicode) cho c¸c c¬ së 
d÷ liÖu phæ th«ng: MS Access, Foxpro, SQL Server, Oracle. 

o Vietkey Linux: HÖ ®iÒu hµnh th−¬ng hiÖu ViÖt Nam, 1 ®Üa CD duy 
nhÊt bao gåm hÖ ®iÒu hµnh vµ c¸c øng dông v¨n phßng, giao diÖn 
vµ h−íng dÉn sö dông Online b»ng tiÕng ViÖt Unicode/TCVN 
6909. 

o Vietkey4Palm, Vietkey4CE: Bé gâ tiÕng ViÖt cho c¸c m¸y PDA 
cÇm tay PALM vµ PocketPC, hç trî tiÕng ViÖt Unicode vµ TCVN 
5712 (15 Font ch÷ mü thuËt). 

o AnyTimeOnline, gi¶i ph¸p m¹ng m«i tr−êng céng t¸c cho qu¶n lý 
®iÒu hµnh cho doanh nghiÖp vµ c¸c tæ chøc nhµ n−íc, h¹ tÇng c¬ së 
cho th−¬ng m¹i ®iÖn tö vµ chÝnh phñ ®iÖn tö (www.vietkey.net).  

o T3c - HÖ qu¶n lý c¸c ®èi t−îng trªn nÒn b¶n ®å sè (GIS), (®« thÞ, 
m¹ng c¸p, qu¶n lý dù ¸n...) 

o C¸c phÇn mÒm qu¶n lý hµnh chÝnh: nh©n sù, c«ng v¨n, vËt t−, tµi 
chÝnh...phôc vô c¸c c«ng t¸c qu¶n lý hµnh chÝnh. 

o T− vÊn, x©y dùng c¸c hÖ thèng an toµn b¶o mËt th«ng tin... 

o HÖ thèng th−¬ng m¹i ®iÖn tö B2B:  www.xvmart.net  
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o ThiÕt kÕ c¸c hÖ thèng phÇn mÒm vµ phÇn cøng nhóng dïng trong ®o 
l−êng ®iÒu khiÓn c¸c qu¸ tr×nh tù ®éng ho¸. 


